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1
INTRODUCTION

The APPLE ][ and IBM PC use completely different
approaches to floppy disk storage. Consequently, an APPLE ][
disk cannot be directly used in an IBM PC and vice versa.
Previously, the only practical method for transferring files between
an APPLE ][ and IBM PC involved slow, complicated serial file
transfer methods.

Apple-Turnover’s specially designed hardware and software
enables your IBM PC to directly read and write APPLE ][ disks.
Now, you can copy files between APPLEDOS 3.3, APPLE CP/M,
and IBM MS-DOS disks easily and quickly.

1.1 Functional Description
Apple-Turnover consists of the following:

e A printed circuit card that fits into an expansion slot inside
your IBM.

e A program disk with software to read, write and format
APPLE disks in your PC.

e Documentation consisting of this User’s Guide, product war-
ranty, software license agreement, and registration card.

Apple-Turnover is intended for the IBM PC, XT and selected
"PC-compatible” computers. It enables these host computers to
directly read, write and format APPLEDOS 3.3 and APPLE CP/M
disks. Consequently, you can easily transfer files from APPLE
disks to IBM disks, and vice versa.

‘Apple-Turnover can be used to copy or transfer any type of
disk file including APPLE text files, APPLESOFT programs,
APPLE integer basic programs, APPLE binary files, MS-DOS
binary and text files, etc.
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NOTE

Apple-Turnover will not transfer files from copy-protected disks.

Text files and various types of datafiles can usually be used on
the other computer ”“as-is” or with minor modifications. An addi-
tional utility program (ATSIFT) is included in the Apple-Turnover
package for making minor file modifications to text files.

Although executable programs can be transferred from one
computer to the other, they will not generally run. There are, how-
ever, important exceptions. For example, many APPLE CP/M
programs will run on the IBM if you install a Z80 coprocessor card.
Since these cards are expensive, you may want to consider the
"8OMATE CP/M Emulator” from Vertex Systems. This software
enables your IBM to directly run most types of CP/M software,
including APPLE CP/M programs.

The Apple-Turnover printed-circuit card provides the hardware
interface that enables your PC to read and write APPLE ][ disks.
The Apple-Turnover software activates the card when required to
read, write or format APPLE disks. The Apple-Turnover card has
no effect on normal operation and can remain permanently installed.

Since the printed-circuit card remains “invisible” during nor-
mal operations, we can discuss the Apple-Turnover’s features in
terms of the supplied software. The main programs supplied are
described in Table 1-1.

These programs are fully-menu driven and easy to use. Each
program contains user-selectable options to help match program
function to your specific needs.

1.2 User Support

If you need help, please refer to the Appendices for a descrip-
tion of our support services and policies. Please note that a signed
registration card must be on file BEFORE we can provide customer
support.



Table 1-1. Apple-Turnover Programs

ATREAD copies files from APPLEDOS 3.3 or APPLE CP/M
disks to MS-DOS disks.

ATWRITE copies files from IBM format, MS-DOS disks to
APPLEDOS 3.3 or APPLE CP/M disks.

ATINIT initializes blank disks for APPLEDOS 3.3 or formats
disks for APPLE CP/M.

ATSIFT modifies MS-DOS text files by adding or removing
linefeeds, stripping the high-bit, etc.

1.3 Documentation Notes

Throughout this documentation, please note the following con-
ventions:
Table 1-2. Notation in This Guide

COMMAND Program commands or user input are shown in
upper-case type.

[Enter] The “Enter” (or Return) key terminates most com-
mands or other user keyboard input.

[F1] Function-key commands are shown in parenthesis.
Pressing the [Enter] key is not required.

Qorq Single-letter commands can be entered in either
upper or lower-case, but are shown in upper-case.

MS-DOS MS-DOS refers to PC-DOS as well.
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2
INSTALLATION

Apple-Turnover installation consists of:

e making sure your computer meets minimum system
requirements (see Section 2.1)

e reading the enclosed software license agreement and product
warranty, and returning your product registration card .,

e installing the printed-circuit card in one of your computer’s
expansion slots

e preparing an Apple-Turnover work disk from the original
program disk, storing the original disk in a safe place
2.1 Minimum Requirements

Please check to make sure that your computer meets the mini-
mum hardware and software requirements outlined in Table 2-1.

Table 2-1. Minimum System Requirements

COMPUTER IBM PC, IBM PC-XT, or selected "PC-compatible”
computer

MEMORY 192 KB minimum of main system memory

DISKS Two floppy disk drives, or one floppy disk drive plus
an "XT-compatible” hard disk system

MS-DOS PC-DOS version 2.xx or the MS-DOS equivalent is
strongly recommended. Under earlier versions, many
important features like filename wildcards, etc. are
not available.

Apple-Turnover will not function properly with some
computers and peripherals. These are listed in the Appendices.



Your Apple-Turnover package should contain the following
components: (1) Apple-Turnover board, (2) auxiliary cable, (3)
program disk, (4) program manual, (5) product warranty, (6) soft-
ware license agreement, (7) registration card, and (8) problem report
form.

Apple-Turnover is sold with a warranty covering materials and
workmanship of the printed-circuit card. Proprietary software is
furnished under the terms of the enclosed license agreement without
express or implied warranty.

Please read the warranty and license agreement. Then, please
sign the enclosed product registration card indicating your
acceptance of the license agreement, and mail the card within 10
days of purchase.

2.2 Installing the Card

This section presents instructions for installing the Apple-
Turnover printed-circuit card in an IBM PC or XT. This approach
will also work for selected PC-compatible computers.

If you have installed non-IBM components in you IBM PC or
XT, have a Compagq, or need additional information, please refer to
Appendix 2.

The Apple-Turnover printed-circuit card is the -electronic
interface that enables your PC to read and write Apple disks. The
Apple-Turnover software will not function unless the card is
installed. Since the card has no effect on ordinary disk function,
you may leave it permanently installed.

Conceptually, the Apple-Turnover card is installed in series
with your existing disk controller card. Figure 2-1 below shows the
original configuration in most computers.

After you install the Apple-Turnover printed circuit card, your
computer configuration will resemble the sketch in Figure 2-2.

If you are installing Apple-Turnover in an IBM PC or XT,
then follow the instructions in the next section. Check the Appendi-
ces for Compaq installation instructions. Contact your dealer or
Vertex Systems for help with installation in other computers.
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Figure 2-2. Configuration After Installing Apple-Turnover



NOTE

The Apple-Turnover card can be installed almost anywhere between
the disk drives and disk controller card. Just make sure that “pin 1’
on the drives, boards and cables (colored stripe) all mate properly.

2.2.1 Procedure

Use the following procedure for installing the board in an
IBM PC or PC-XT oniy:

STEP 1 Gather the following items: the Apple-Turnover card, the
supplied auxiliary cable, and a medium-size, fiat-bladed
screwdriver. A smaller phillips or cross-head screwdriver
is also useful.

STEP 2 Turn off your computer’s main AC power switch and
remove the AC power cord from the electrical socket.
Attempting to install the board while the AC power is on
will damage the board, vour computer, and void vour
warranty.

STEP 3 Remove the computer’s cover to obtain access to the
expansion slots. Refer to your computer operating man-
ual for additional information on removing the cover.

STEP 4 Locate your floppy disk drive controller board.

The controller board is usually plugged into a full-length
slot closest to the power supply box. Look for a card
connected to the floppy disk drives by a wide ribbon
cable.

STEP 5 Note the orientation of the cable attached to the conirol-
ler board. The colored stripe on one edge of the ribbon
cable shows “pin 1”7 and can be used as an aid to
orientation.
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STEP 6

STEP 7

Unplug the ribbon cable attached to your disk-drive con-
troller board by pulling back on the plastic connector.
Gently rock it off the card-edge connector by pulling it
slightly on each side until it’s loose.

Orient the Apple-Turnover card such that you can read
the serial number in the lower left-hand corner. Locate
two different sets of ribbon cable connectors in the top
left area of the board.

(see Figure 2-3) The card-edge connector is labeled "J1.”
The pin connector is labeled “J2” just to the right.

top
|
— 12
|== oo [ vertical pin
l==2 OO
|== 00O = card-edge
front |== oo connector
|l==J1 OO 12
|== 00O
|== OO

Figure 2-3. Cable Connections

Plug the ribbon cable you removed from the disk control-
ler board onto the card-edge connector (J1) of the Apple-
Turnover board. The colored stripe on the ribbon cable
should be oriented towards the top of the card, matching
the number ”2” silk-screened on the Apple-Turnover
board.

Take the cable provided with Apple-Turnover and locate
the colored stripe (pin 1) on the edge of cable. On the
Apple-Turnover board, locate the gold pin connector (J2).
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STEP 8

STEP 9

STEP 10

STEP 11

Carefully plug the female pin connector on the supplied
ribbon cable into the male pin connector on the board.
The colored stripe on the ribbon cable should be oriented
towards the top of the board, matching the orientation of
the original disk drive cable.

Locate a free expansion slot. If the original metal
bracket cover is still in place, use a screwdriver to remove
bracket retaining screw. Then, remove the metal bracket
that covers the cut out in the back panel of the computer
chassis. Save the retaining screw.

Position the Apple-Turnover card over the expansion slot
so that the metal bracket will slip behind the cut out in
the back panel. Lower the card until it rests on the slot.

Keeping the card level, use even pressure on the back and
front of the card to press it straight down.

The metal bracket on the Apple-Turnover board should
be flush against the back of the computer chassis. Use
the retaining screw you removed earlier to secure the
metal bracket to the chassis.

Take the ribbon cable coming from your Apple-Turnover
board and plug it into the disk controller card. Don’t
forget to make sure the cable stripe is up.

All the cables should be plugged in. If you have one
loose, go back to the beginning of this section and retrace
the steps for installation.

Replace the case on the computer. This completes the
printed-circuit board installation.

2.2.2 Problems

If your disk drive(s) stay on when you power up your
computer, one of the ribbon cables (either the newly supplied cable
or your original disk drive cable) has been installed upside down on
the Apple-Turnover board.
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This will not harm your drives or controller. To restore nor-
mal operation, turn off the AC power to your computer, check the
cables for a reversed cable, and correct the situation.

2.3 Software Installation

Software installation consists of “backing-up” the Apple-
Turnover programs and installing all or a portion of MS-DOS.
Please note that there are two different procedures. Section 2.3.1
presents the procedure for a PC with floppy disk drives. Section
2.3.2 presents a different procedure for an IBM XT or a PC with an
"XT compatible” hard disks.

The Apple-Turnover programs are provided on an IBM for-
mat, MS-DOS disk. The disk is not copy-protected. However, the
disk or individual disk files should be copied only in accordance
with the license agreement.

2.3.1 PC Installation

This section describes the installation procedures for a PC
with floppy-disk drives. Use the process described below to produce
an Apple-Turnover work disk. Store the original Apple-Turnover
program disk in a safe place.

Use the following procedure to prepare a work disk from the
original program disk:
1. Place a write-protect tab on the original Apple-Turnover
program disk.

2. Insert your MS-DOS system master disk in Drive A and boot
your computer using your normal startup procedure.

3. Insert a blank disk into Drive B.
4.  Enter the command: FORMAT B:/S [Enter]

5. When the formatting operation is completed, remove the sys-
tem master disk from Drive A and insert the Apple-Turnover
disk.
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Issue the command: COPY A:*.* B: [Enter]

After all files have been copied from the Apple-Turnover
program disk to your new work disk, remove the program
disk from Drive A and store it in a safe place.

2.3.2 XT Installation

If vou are using a hard disk computer similar to an IBM XT,

then use the following procedure:

1.

Place a write-protect tab on the original Apple-Turnover
program disk.

Create or choose a directory on your hard disk for the Apple-
Turnover programs. Make this the active directory on the
hard disk.

Insert the Apple-Turnover program disk into Drive A.

Enter the command: COPY A:*.* C: to copy all the Apple-
Turnover programs from the program disk to your hard disk.

After the copy process is completed, store the original
program disk in a safe place.

NOTE

Default program options initially
are set for an IBM PC with two
floppy disk drives. Oun an IBM XT
or similar hard-disk computer,
you must change the program op-
tions for proper operation. Refer
to Section 4.1 for instructions.
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3
TUTORIAL

The Apple-Turnover programs share a common “user-

interface.” Learn

to use one program, and you have learned how to

use them all. Despite the similarity, there are still some important
differences between the various Apple-Turnover programs. There-
fore, this summary is organized as follows:

Sect. 3.1
Sect. 3.2
Sect. 3.3
Sect. 3.4
Sect. 3.5
The general

= below:

introductory material

general instructions for all programs

specific instructions for ATREAD and ATWRITE
specific instructions for ATINIT

specific instructions for ATSIFT

approach to using Apple-Turnover is summarized

PLAN ACTIVITIES Select the files to be copied from one disk

FORMAT DISKS

COPY FILES

MODIFY FILES

format to the other. Gather enough blank or
pre-formatted disks, and label them for easy
identification during your work.

Run the ATINIT program to format blank
disks for APPLEDOS or APPLE CP/M as
required.

AL : Y/ ! ) 5. Run
the ATWRITE program to copy files from
MS-DOS disks to APPLE disks.

Use the ATSIFT program (as needed) for
ASCII  text files that need minor
modifications.



3.1 Introduction

In the material that follows, a section of text is often devoted
to explaining a single menu screen. These sections will be headed
by a flow diagram or “roadmap” similar to the example shown in
Figure 3-1.

Present Available
Menu Choices Command
TITLE PAGE continue [F1]
Options Menu [F2]
Exit [F10]

Figure 3-1. Example of Program Roadmap

In Figure 3-1, The legend on the left (TITLE PAGE) identifies
the present menu or screen. The legends in the center column
(Format Menu, Options Menu, etc.) show possible selections for
next action. The right column shows the command required for
each selection. For example, to move from the TITLE PAGE to
the Options Menu, press function key [F2].

Menu selections and most other commands can be entered
using either of the methods described below:

1. FUNCTION KEYS

press a function key corresponding to the desired com-
mand. Each menu screen will display the active function
key selections in inverse video along the bottom of the
screen.

2. "ALPHA” KEYS

press a key (upper-case or lower-case) corresponding to the
first letter of the command name. For example, press the
key for the letter "Q” (or "q”) to execute the command
"QUIT.”
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Function-key commands and corresponding “alpha” key com-
mands are identical. This control setup enables you to program the
function keys for other tasks wusing a utility like Vertex’s
KEYSWAPPER while retaining control of Apple-Turnover through
the ”alpha” key commands.

All menus share a common basic screen layout. In this guide,
the screen menu is represented by the drawing shown in Figure 3-2.

SCREEN NAME Program Name

(central display area)

[F1] command [F2] command [F3] command [F10] Exit

Figure 3-2. Menu Screen Layout Example

All screens display the name of the current program or
program function in the upper right-hand corner. The current
screen or screen function is displayed in the upper left hand corner.
Function key selections are displayed along the bottom of the
screen. The lower central part of the screen usually displays
corresponding ”“Alpha” key commands.

3.2 Common Procedures

The following instructions apply to all Apple-Turnover
programs.

3.2.1 Startup

On floppy-disk based systems, insert your Apple-Turnover
work disk in Drive A and boot the computer. If your computer is
already at system level, be sure you see the "A” prompt on your
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screen.

On an IBM-XT or similar hard disk-based computer, boot
from the hard disk as vou normally would. Use the DOS "CD”
command to switch to the directory containing the Apple-Turnover
programs. Please note that the MS-DOS "PATH” capability is not

supported. All files will be copied to and from the same directory
that contains the Apple-Turnover programs.

Select the desired Apple-Turnover program by entering one of
the following commands:

ATWRITE [Enter] to copy files from an MS-DOS disk to

an APPLE disk

ATINIT [Enter] to format a blank disk in an APPLE
disk format

ATSIFT [Enter] to modify text files

After entering one of the commands listed above, the
corresponding program will load from disk and execute. After the
title page appears on your video display, you may remove your
Apple-Turnover work disk (for floppy-disk systems). Since the
program has been locaded into memory, the disk drive that
previously contained your Apple-Turnover work disk is now
available for copying files.

Most of the Apple-Turnover programs store default program
options in separate disk files. These files have an ".QPT” filetype or
suffix in the filename (e.g. ATREADDEF.OPT, etc.}. These default
options files must always reside on the same floppy disk, or in the
same subdirectory, as the other Apple-Turnover programs. If you
accidently try to run one of the programs without its companion
default options file, the program will cease execution and DOS will
display a “file not found” error.




3.2.2 Title Page Menu

Present Available
Menu Choices Command
TITLE PAGE APPLE Formats [Enter]
Options Menu [F2]
Exit [F10]

Figure 3-3. Title Page Roadmap

Each program presents a “title page” screen that displays the
program name, version, serial number and copyright notice. Take
one of the following actions:

e On floppy disk systems, press [Enter] to continue.

e On hard disk systems:

— press the letter “O” or function key [F1] to enter the
Options Menu.

— enter “"XT"” for type of host computer
— press function key [F1] to leave the Options Menu

Please refer to the Program Reference Section to learn how to
change program options, load and save modified default options
files, etc.

3.2.3 Select Apple Format

Present Available
Menu Choices Command
APPLE FORMATS APPLEDOS 1
APPLE CP/M 2
Options Menu [F3]
Exit [F10]

Figure 3-4. APPLE Disk Formats Roadmap
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Apple-Turnover supports APPLEDOS 3.3 and APPLE CP/M.
Computers that use the standard, unmodified 16-sector APPLEDOS
3.3 disk format should be compatible with Apple-Turnover.
APPLE CP/M disks must be compatible with the Microsoft
Softcard disk format.

Select the desired APPLE disk format from the menu. Type
the numeral ”"1” or “27 {Enter] to select the desired APPLE disk
format. Alternately, press function-key [F3] to exit from Apple
Formats Menu and enter the Options Menu. Press [F10] to Exit.

3.2.4 Exit Menu

Present Available
Menu Choices Command
EXIT run ATREAD [F2]

run ATWRITE [F3]

run ATINIT [Fd]

exit to DOS F10]

Figure 3-5. Exit Screen Roadmap

The Exit screen is similar to a road or highway that forks into
several different directions. You can exit from the current Apple-
Turnover program and return to DOS, or you can run one of the
other Apple-Turnover programs.

On floppy-disk systems, be sure to remove the current disk
from the active or default drive and re-insert the Apple-Turnover
work disk before making your command selection.

3.2.5 Error Handling

With a few exceptions, the Apple-Turnover programs manage
to trap most errors. Functionally, this means that you can correct
the problem and continue, instead of “crashing” the program and
starting all over again.

el
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When a problem occurs, an “ERROR!” screen will appear
explaining the problem and offering several options for further
action. Please refer to Section 7 (Solving Problems) for additional
information about the ERROR! screen.

3.3 ATREAD/ATWRITE Procedures

The previous sections presented instructions for menus or pro-
cedures that apply to all programs. This section presents
instructions for the remaining ATREAD and ATWRITE menu

screens.

The ATREAD and ATWRITE are almost mirror images of
one another. The ATREAD program copies or transfers files from
an APPLE disk to an MS-DOS disk. The ATWRITE program is
virtually identical, but it transfers or copies files in the opposite
direction: MS-DOS to APPLE.

3.3.1 Insert Disks Menu

Present Available
Menu Choices Command
INSERT DISKS continue [F1]
APPLE Formats [F2]
Options Menu [F3]
Exit [F10]

Figure 3-6. Insert Disks Roadmap

After the desired APPLE format is selected, you are prompted
to insert the proper disk or disks in their respective drives. Please
read the instructions on the screen indicating the proper disk drive
for the “source” disk and “destination” disk.

The meaning of source and destination disk will change
depending on the program in use (ATREAD or ATWRITE). Please
note that files are always copied FROM the source disk TO the
destination disk. These designations will change depending on the
Apple-Turnover program in use.
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Any available disk drive in your system can be the source disk
or the destination disk. Fach Apple-Turnover program has default
disk drive assignments that can be changed within the Options
Menu.

After inserting the proper disk in the correct drives, press
{Enter] or function key [F1} to read the catalog or directory of the
APPLE disk. You may, instead, return to the Format menu,
Options menu, or exit.

3.3.2 Select Files Menu

Present Available
Menu Choices Command
SELECT FILES pick files to copy

ask/copy files (#) [F1]
copy all files (*) [F2]
Newdisk [F3}
Options Menu [F4]
APPLE Formats [F5]
show MSDOS direct. [F6]
re-display screen [F7]
Exit [F10]

Figure 3-7. Select Files Roadmap

The “Select Files” screen is usually the center of activity. The
general approach to using the this screen is summarized below:

e view the APPLE disk catalog or directory, and (optionally)
the MS-DOS disk directory

@ select the desired files by type the filename, with or without
"wildcards”

@ copy the selected files from one disk to the other

@ repeat this process as desired
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e alternately, use the function keys to insert another disk,
change APPLE format, change the program options, exit to
another Apple-Turnover program, or exit back to MS-DOS

The following sections describe the most important aspects of using
the ”Select Files” screen.

3.3.2.1 Directory Displays

 After inserting the disks in the proper drives, the process of
reading the catalog or directory of the APPLE disk will begin. The
program will inform you of its progress by displaying the count of
the directory sector or record currently being read.

After-successfully reading the entire catalog or directory, the
contents of the APPLE disk will be displayed. Note the example
APPLEDOS catalog shown in Figure 3-8.

Sorted Catalog of APPLEDOS 3.3 Disk

CURVE FIT *A
HELLO *A
MAGIC T
PIX B
PLOT6A A
RIAMU MASTER *A
RIAVOL T
RIAXY MASTER *A
DOIT TO ME I

Figure 3-8. Apple-Turnover Display of an APPLEDOS Catalog

The filenames are sorted alphabetically for your convenience.
The code letter to the right of each filename shows the type of
APPLEDOS file. The code is displayed in Table 3-1.

When ATWRITE copies a file from an MS-DOS disk to an
APPLEDOS disk, you will be prompted to enter the filename and
the APPLEDOS file type. Please enter the byte value 0, 1, 2, or 4
as appropriate. Most of the time, the byte value 4 for text file will
be appropriate. Text files will have their “eighth bit” set
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Table 3-1. APPLESQOFT File Codes

CODE BYTE VALUE  FILE TYPE

A 0 APPLESCFT
1 1 integer Basic
T 2 Text

B 4 Binary

* + 128 locked

automatically as they are copied from MS-DOS to APPLEDOS.
Entering the wrong file type code may make the file unusable in the
APPLE computer.

APPLE CP/M directories are displayed in alphabetical order.
No additional information is displayed.

The directory of the MS-DOS disk can be displayed by
pressing function key [F6]. To recall the Apple directory, press
function-key [F7].

3.3.2.2 Selecting Files
There are four ways to select files:

1. press [Enter] to select the default filename (# unless changed
in Options Menu)

2. select a single file by entering the complete and accurate
filename

3. select several similar files by entering a generic filename using
"wildcards”

4.

The simplest (and least efficient) method for selecting a file to
copy involves typing the complete filename at the prompt. The

P

filename may be typed in upper-case or lower-case letters. Your ¢
input is converted to upper-case unless vou change one of the =
default options within the Options Menu.
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APPLE CP/M filename syntax is virtually identical to MS-
DOS. However, the syntax of APPLEDOS filenames is different
from the syntax used by MS-DOS and CP/M. If you are not
familiar with APPLEDOS and MS-DOS filename conventions, be
sure to read Section 5-1 before proceeding.

Select a similar class of files by using the four types of
wildcard characters supported by the Apple-Turnover programs.
These are listed in Table 3-2 below.

Table 3-2. Filename Wildcards

? represents any single character

* represents any combination of characters in
the filename or extension

! just like ”?” except the program will pause to
ask: (Yes/No) before copying

# just like ”*” except the program will pause to
ask: (Yes/No) before copying

The first two shown in Table 3-1 are the standard wildcards used
within MS-DOS and CP/M. The last two are additional
wildcards provided by Apple-Turnover to support “queried”
filename selection. Queried filename selection means that the
program will ask whether a file should be copied before it proceeds
to do so.

This leads to the two most common uses of filenames. Note
that function key [F1] selects ”“*.*” and function key [F2] selects
"#.#" as the desired filename. The ”*.*” selection will copy all the
files on a disk. It use is the same as it would be under MS-DOS or
CP/M. The "#.#" selection is just like "*.*” except that you will
be asked whether to copy each file.

Due to the vast differences between APPLEDOS and MS-DOS
filenames, selecting either ”"*” or “# ” will force you to rename each
file as it is copied. Make sure to enter a legal MS-DOS filename for
each APPLEDOS file copied.
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3.3.2.3 Copying the File

After selecting the desired files, ATREAD will begin the
process of copying the files from the APPLE disk to the MS-DOS
disk. The cumulative quantity of sectors or characters transferred
for each file will be displayed along the boitom of your screen.

For APPLEDOS, the sector count proceeds from sector 0, not
sector 1. Therefore, if your APPLEDQOS file consists 20 sectors,
then the file transfer will be completed at sector #19, not sector
#20.

With APPLEDOS, sclecting ™" {copy all files), or "#”
(queried copy of all files) automatically invokes the “rename” mode.
Each APPLEDOS filename will be displayed with a prompt
requesting the new MS-DOS filename. Please note the following
important guidelines:

e Most APPLEDOS filenames do not qualify as legal MS-DOS
filenames and must be renamed.

Pressing  [Eait 5 srallyy { #iThe truncated
APPLEDOS filename may contain spaces, punctuation, identi-
cal characters in the first 12 letters of the name, etc. that will
cause problems under MS-DOS.

Under APPLE CP/M, none of these difficulties exist because
MS-DOS and CP/M filenames are virtually identical in structure.

When ATWRITE copies files from MS-DOS to APPLEDOS
disks, there is an additional consideration. As shown in Table 3-1,
APPLEDOS 3.3 recognizes four different types of files. In an
APPLEDOS disk catalog, each file entry contains code indicating
file type.

When an MS-DOS file is copied to an APPLEDOS disk, the
ATWRITE program has no way of knowing the intended type of
APPLEDOS file. Therefore, you must enter a file type code for
cach file copied.
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The Select Files screen will prompt you to enter a file code
before the file copy begins. Enter the numeral "0” for ASCII text
files. Enter the numeral ”1” to indicate an APPLE Integer Basic
file (stored as integer basic tokens and strings, not converted to
ASCII). Enter the numeral "2” to indicate an APPLESOFT file
stored as tokens and strings. Finally, a “4” indicates an APPLE
6502 binary file. Please refer to Section 5 for additional informa-
tion and examples of APPLESOFT file codes.

As a note of warning, it is important to enter the correct file
type code. Otherwise, the file copied to your APPLEDOS disk may
not be directly usable in the APPLE computer.

3.3.2.4 NEWDISK Function

If you wish to substitute another APPLE disk for the one
currently in use, you must use the /NEWDISK” (function.
Exchange the disks. Then, press function key [F3]. The program
will display the “Insert Disks” screen.

Press [Enter] to continue. The APPLE disk catalog or direc-
tory will be read from the newly inserted disk. You will be
returned to the ”Select Files” screen and may proceed as desired.

3.3.2.5 Changing Apple Formats

Pressing function key [F5] enables you to change APPLE
disk formats with an automatic "NEWDISK” as well. After
pressing the function key, the ”Apple Formats” screen will be
displayed.

Select the desired APPLE disk format. The “Insert Disks”
screen is displayed. Insert the new disk in the proper disk drive.
Press [Enter] to read the new disks catalog or directory. You are
then returned to the ”“Select Files” screen.

3.4 ATINIT Procedures

The ATINIT program will format blank disks for APPLE
CP/M and initialize blank disks for APPLEDOS 3.3. The
initialization process for APPLEDOS disks will format the disk and
write a "HELLO” file. However, ATINIT does not write an
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APPLEDOS system onto the disk. Therefore, the resulting
APPLEDOS disk will not boot in an APPLE computer.

In a similar fashion, ATINIT does not write a CP/M system
onto a formatted disk. In both cases, this should cause no prob-
lems whatsoever. Use the disks as data disks. '

The material that follows discusses unique aspects of the
ATINIT program.

3.4.1 Insert Disks Menu

Present Available
Menu Choices Command
INSERT DISKS continue [Enter]
APPLE Formats [F2]
Options Menu [F3]
Exit [F10]

Figure 3-9. Insert Disks Roadmap

Place the blank disk to be initialized or formatted into the tar-
get disk drive. The target disk drive is displayed on the "INSERT
DISKS” screen. On a floppy-disk system, the default target drive is
Drive B. On an XT, the target disk drive is Drive A. The target
disk drive assignment can be changed from the Options Menu. As
a safety precaution, remove all disks from other floppy disk drives.

The initialization or formatting process is not particularly
rapid. It takes about two to three minutes to complete the
operation.

3.5 ATSIFT Procedures

The Apple-Turnover Sift program (ATSIFT) is a utility for
making minor modifications to text files. Minor changes to are
sometimes required to make APPLE text files usable in MS-DOS
applications and vice versa.
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ATSIFT can modify ASCII text files in the following ways:

1. convert Wordstar document files to standard ASCII text files
2. strip the ”high bit” from ASCII text files

3. remove a linefeed character after each carriage return charac-
ter

4. remove carriage return characters
5. remove the combined carriage return-linefeed characters
6. do simple search and replace functions

Please refer to Section 4 (Program Reference) for additional
information about these functions.

To run ATSIFT, type the command: ATSIFT [Enter]. When
prompted, type the name of the ASCII text file to be modified.
Then, type the name of the new file that will contain the modified
text. Do not use the same filename for both.

After entering the names of the original, source text file and
the new, modified text file, the main menu will be displayed. Select
the desired type of modification. Exit the program when
modifications have been completed.
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4
REFERENCE

4.1 Program Options

The Apple-Turnover programs can be modified to meet specific
needs through a system of user-selectable program options. The
following points summarize how the system works:

e Each program (except ATSIFT) uses several different global
options.

e Each program initially reads a set of default options from a
disk file. These default option settings remain in effect unless
changed.

e Individual option settings can be temporarily changed within
the Options Menu. Temporary changes can be saved in a disk
file and recalled when needed.

e You can modify or duplicate options files as desired. How-
ever, a default options file must be available for each
program.

4.1.1 Default Options Files

Your program disk contains files which store default options
for each program. Each Apple-Turnover program has a specific
default options file. The name of the default options file must not
be changed. Table 4-1 lists the default options file for each
program.

Table 4-1. Default Options Filenames

Program Default Options File
ATREAD ATRDEF.OPT
ATWRITE ATWDEF.OPT
ATINIT ATIDEF.OPT
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A properly named copy of each required option file must
always reside on your Apple-Turnover disk. If this file is not
available, then the Apple-Turnover program will abort displaying
the following DOS error message: “File not found ...”

If the default options file on your work disk is accidentally
erased or damaged, then it can be restored by copying the options
file from the original program disk.

Any operation involving program options takes place within
the Options Menu. This menu can be accessed from the program
title page and from most other program menus. The next section
describes the Options Menu screen and defines the program options.

4.1.2 The Options Menu

Present Available
Menu Choices Command
OPTIONS MENU change option
continue [F1]
Load New Options iF2]
Save New Options [F3]
Exit [F10]

Figure 4-1. Onptions Menu Roadmap

Within the Options Menu, the setting of individual program
options may be changed. Many settings are changed by typing a
Y7 {for "ves”} to activate the option, or "IN” (for "no”) to deacti-
vate the option. Others reguire a disk drive letter, number, or
filename.

Pressing the [Enter] key moves the cursor down to the next
row in the option column. You can use the up and down cursor
kevs to move the cursor along the options column. The backspace
kev will delete characters to the left of the cursor.

After making some changes, press function key [F1] to con-
tinue to the next program menu. In this instance, the modified
program options will remain in effect for the current session only.
The next time vou run the program, the default options will be back
in effect.
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If you want to use the modified options at some later date,
they can be saved to a file. Press function key [F3]. The program
will prompt: “Filename to write?” Enter the name of the new
options file and press [Enter], or just press [Enter] if you want the
changes to be saved to the default options file.

To load an alternate options file, press function key [F2]. The
program will prompt: “Filename to read?” Enter the name of the
desired file and press [Enter]. However, if a nonexistent or
incorrectly spelled filename is entered, the program will abort. DOS
will display a “File not found ...” error message. You will need to
restart the program.

Finally, press function key [F10] to leave the Options Menu
and go to the "Exit” screen.

4.1.2.1 ATREAD/ATWRITE Options
The following material describes the program options shown in Fig-
ure 4-2.

1. Which Machine (PC/XT)

The default value is "PC” which may be changed to "XT.”
This option sets internal program parameters. The "PC”
setting will work with a PC or XT. If your computer is
neither an IBM PC, XT or similar compatible, use the
default "PC” mode.

2. Which drive contains APPLE disk to read
— ATREAD

The source disk is an APPLE disk. The default set-
ting is Drive B (assuming a floppy-disk system). On
hard-disk systems (XT), change the source drive to
Drive A.

— ATWRITE

The source disk is an MS-DOS floppy or hard disk.
The default setting is Drive A (assuming a floppy-disk
system). On hard-disk systems (XT), change the
source drive to Drive C.
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OPTIONS ATREAD

Which Machine (PC/XT)

Which drive contains APPLE disk to read
Which drive contains MS-DOS disk to write
What is the default format number

What is the default filename

Display files on screen during transfer

Show record boundaries when files displayed
Suppress copying (view file only)

Change filename when copyed

Consider lower case same as upper case
Ignore rest of file after Ctrl-Z

Strip high bits in text files

How many retries on read error

RCZRZZZZ 3" P> WO

[F1] Continue  [F2] Load  [F3] Save  [F10] Exit

Figure 4-2. ATREAD Options Menu Screen

3. Which drive contains MS-DOS disk to write
— ATREAD

The destination disk is an MS-DOS floppy or hard
disk. The default setting is Drive A (assuming a
floppy-disk system). On hard-disk systems (XT),
change destination drive to Drive C.

— ATWRITE

The destination disk is an APPLE disk. The default
setting is Drive B (assuming a floppy-disk system).
On hard-disk systems (XT), change the destination
drive to Drive A.
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4. What is the default format number

Designates whether Apple-DOS 3.3 or Softcard CP/M is
the default format. In the Apple Formats menu, pressing
[Enter], instead of the number “1” or ”2,” will select the
format currently designated as the default format.

5. What is the default filename

The default setting is the pound sign (#), which will query
for each file. Use an asterisk (*) instead to copy every file
on the disk without a query.

Any valid filename may be entered as the default filename.
For APPLEDOS, the default filename may be up to 30
characters in length and may contain wildcards.

The filename designated is used in the Select Files menu.
Within the Select Files menu, press [Enter] to input the
default filename and begin the file copy operation.

6.  Display files on screen during transfer

Activate this option to display a file’s contents on your
screen as it is copied. The default setting is “N” for NO
display. Enter "Y” (for YES) to activate the file display
mode.

This feature is really intended for readable ASCII text files.
It should not be used with binary files or other files that do
not contain readable text. If you attempt to display the
contents of binary files, expect to be treated to a
"fireworks” display of jumbled characters and graphics
jumping around the screen with bells and whistles. How-
ever, the file will still transfer OK.

APPLESOFT and APPLE integer basic files are normally
stored as binary files and cannot be viewed directly using
this option.

While viewing a file, the video scroll can be paused by
pressing “(Ctrl)-(Numlock)” simultaneously. Press any key
to restart the display.
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10.

Show record boundaries when files displayed

Activate this option to insert record boundary headers into
the display of ASCII text files. Combine the headers with
printed output (Ctrl-P will toggle your printer ON and
OFF) for a complete record. This feature is useful in cer-
tain specialized applications.

Suppress copying (view file only)

This option should only be activated along with the
Display Files option. Activating both options (by entering
a "Y” for yes) will display an ASCII text file’s contents
without copying the file. This combination of options is
equivalent to the MS-DOS or CP/M "TYPE” command.

Change filename when copyed

Activate this option to change a filename when it is copied.
This function is similar to the MS-DOS "RENAME” com-
mand.

The use of wildcard filenames like “*” and ”#” in the
Select Files menu for APPLEDOS disks will automatically
activate this option.

Consider lower case same as upper case

In the default mode, the significance of upper case vs.
lower case in filenames is ignored. User input and direc-
tory entries are all considered to be upper case. In most
instances, this default setting should not be changed.

Deactivate this option by entering "N” (for NO). Then,
the case of entered filenames and directory or catalog
entries must be identical. If a lower-case filename is
entered in the Select Files menu in search of an identical
(but UPPER CASE) filename, the program will not find a
match. Similarly, using ATWRITE, making a lower-case
directory entry on a disk where the operating system
expects upper-case entries may make the file “invisible.”



A third setting involves entering "A” (for ASK). In this
mode, the program will querv when it finds entries that
match except for case difference.

11. Ignore rest of file after Ctrl-Z

This option limits file size growth when using ATREAD.
Normally, ATREAD will pad the last physical sector of a
file as it is copied onto the DOS disk. This nsually causes
the DOS copy of the file to be slightly larger than the orig-
inal.

Most of the time, this file size growth is unimportant.
However, some applications programs are sensitive to file
size and will not load critical files properly if the size
changes. These instances are rare.

When this option is activated (type ”"Y” for yes), the last
sector of the file is not padded. The file copy process ter-
minates upon encountering a "Control-Z” character instead
of proceeding to the end of the last physical sector in the
file.

The default setting for this option is "N” or deactivated.
Do not activate this option unnecessarily. You may lose
the end of a file if ATREAD encounters a “Control-Z”
before the end of the disk file. Normally, this option
should only be activated for occasional binary files.

12.  Strip high bits in text files

APPLEDOS likes text files to have the “eighth-bit set” on
each character. MS-DOS is just the opposite. It likes text
files where the eighth-bit is not set. Unmodified APPLE
text files look like a maze of graphics characters on the
IBM and vice versa.

When activated, this option will automatically strip the
high-bit from APPLE text files in ATREAD, and set the
high-bit on MS-DOS files in ATWRITE. This option has
no effect on other types of APPLEDOS files.

4-7

T



This points out the importance of correctly entering file
tvpe codes for APPLEDOCS files within the ATWRITE
program. If an APPLEDOGS text file is incorrectly coded
as a basic or binary file, the eighth-bit processing will not
take place.

The default setting for this option is "Y” or option active,
which allows vou to forget about eighth-bit incompatibility
most of the time. For special applications, enter "N” to
deactivate this option.

13. How many retries on read error

If a error occurs during a disk read operation, the program
will make several attempts to read the problem disk sector
before giving up and displaying the ERROR! screen.
Increasing the number of retries from the default setting of
8 to higher value (15 or 20) will improve vour chances of
reading a marginal disk.

4.1.2.2 ATINIT Options Menu

OPTIONS ATINIT
PC Which Machine (PC/XT)
B Which drive contains APPLE disk to format
1 What is the default format number
8 How many retries on read error
N Continuously format more disks

[F1] Continue [F2] Load [F3] Save [F10] Exit

Figure 4-3. ATINIT Options Menu Screen
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The ATINIT options are similar to those used in ATREAD
and ATWRITE. If you wish to initialize or format several disks at
one time, activate the “Continuous Format” option (by entering "Y”
for yes) to speed up the process.

4.1.3 Using Options Files

If you regularly use Apple-Turnover for repetitive tasks, the
program options disk files can be customized to speed overall
operations. This section describes the following:

e how to save modified program options in a disk file

e how to load a new set of program options from a disk file
e how to modify the default options disk file

e how to create multiple program options disk files

4.1.3.1 Custom Options Files

You can create your own customized options files. This
allows you to easily install desired options settings without going
through the Options Menu to manually reset options.

Use the following steps to create your own default options file:

e Run the desired Apple-Turnover program. Go to the Options
Menu.

e Change the default options settings to the desired values.

e At the bottom of Options Menu, note the legends for function
keys [F2] “Load options file” and [F3] ”Save options file.”
You want to save your new option settings to a file, so press
[F3].

e A prompt will appear on the screen, “Filename to write?”
Enter any valid filename. Make it a habit to end each options
file with the extension ".OPT”. Press [Enter]. A new options
file will be saved to your work disk or directory.

If you decide to switch to your customized file, go to the
Options Menu and press [F2], “Load options file.” Respond to the
prompt, “Filename to read?” by typing the name of your
customized file, and pressing [Enter]. Your customized file will be
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read and the Option Menu settings reset. You can have as many
options files as there is space on your work disk

4.1.3.2 Modifying the Default File

If you are using an IBM XT, or normally need option set-
tings that are different from those that come with the Xeno-Format
program, you may want the program to load your customized
default options automatically

The recommended procedure is described below:

1. Make a backup copy of the original default options file using
a command like: COPY ATRDEF.OPT ATRDEF.BAK
[Enter]. This preserves the original default options file.

~ 2. Run the appropriate Apple-Turnover program. From the Title
Page Menu, press [F1] to enter the Options Menu.

3. Change individual options settings as desired.

4. Press function key [F3] to save vour changes to a file. In
response to the filename prompt, enter the name of the origi-
nal default options file. For ATREAD, the correct filename
would be ATRDEF.OPT, etc.

5. Proceed with other operations, or exit from the Apple-
Turnover program.

6. In the future, whenever you run the Apple-Turnover program,
you modified default options file will automatically be
installed.

This type of procedure is particularly important for those
using an XT or other hard-disk based system. In this case, change
the options as follows: (1) change “Which Machine” from PC to
XT, (2) for ATREAD, change source disk f
destination disk from A to C, (3) £6

for ATINIT, change the drive containing the dlSl; ’to be formatted

from B to A.
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4.2 Using Wildcards

Transferring several files is much easier when “global specifiers”
or wildcards are used in the filename. Instead of laboriously typing
each complete filename, enter some unigue portion of the filename
plus the appropriate global specifiers. The Select Files menu
displays a list of valid Apple-Turnover wildcards.

Four global specifiers or wildcards are available as shown in
Table 4-2. The first two shown in Table 4-2 are the standard
wildcards used within DOS. The last two are additional wildcards
provided by Apple-Turnover for “queried” filename selection.

Table 4-2. Apple-Turnover Filename Wildcards

? represents any single character

* represents any combination of characters in the
filename or extension

! just like ”?” above except the program will
pause to ask: (Yes/No) before copying

# just like “*” above except the program will
pause for query

4.2.1 Wildcards with APPLE CP/M

APPLE CP/M uses the same system of wildcards as other
varieties of CP/M 2.2. This wildcard structure is also similar to the
MS-DOS wildcard structure. Refer to Table 4-2 for a listing of
supported wildcards.

Table 4-3 presents several examples showing the use of Apple-
Turnover wildcards for selecting filenames.

4.2.2 Wildcards with APPLEDOS

The Apple-Turnover wildcards shown in Table 4-2 will also
work with APPLEDOS filenames. However, the vast differences
between APPLEDOS and MS-DOS filename syntax requires some
thought in the use of wildcards.
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Table 4-3. Examples of APPLE CP/M Wildcards

* copies all files on the source disk

* .BAS copies all files with a ".BAS” extension

DATA.* copies all files named "DATA” with any exten-
sion

#.BAS asks whether any file with a “.BAS” extension

should be copied

DAT?.PRN copies all files named "DAT” with any character
in the fourth position and with an extension of
"PRN” (like DATA.PRN, DAT2.PRN, etc.)

DAT#.PRN  similar to the previous example but queries
whether to copy DATA.PRN, DAT2.PRN, etc.

DAT#.# queries whether to copy files beginning with
"DAT” and any additional characters in the
filename or extension.

For example, MS-DOS filenames may not exceed 12 characters
in length. However, APPLEDOS filenames are often more than 12
characters in length. Therefore, Apple-Turnover wildcards may be
used in that portion of the filename past the twelfth character. This
is not possible within MS-DOS or APPLE CP/M.

However, a potentially greater problem is the conversion of
APPLEDOS filenames to legal MS-DOS filename. This occurs
regularly using the ATREAD program. Please refer to section 5.1.1
for additional information.

4.3 APPLEDOS File Codes

When ATWRITE copies files from MS-DOS to APPLEDOS
disks, there is the additional consideration of APPLESOFT file
codes. As shown in Table 4-4, APPLEDOS 3.3 recognizes four
different types of files.
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Table 4-4. APPLESOFT File Codes

CODE BYTE VALUE  FILE TYPE

A 0 APPLESOFT
I 1 Integer Basic
T 2 Text

B 4 Binary

* +128 locked

In an APPLEDOS disk catalog, each file entry contains the
byte value shown above (in hex, not decimal) indicating file type.

When an MS-DOS file is copied to an APPLEDOS disk, the
ATWRITE program has no way of knowing the intended type of
APPLEDOS file. Therefore, you must enter a file type code for
each file copied.

The Select Files screen will prompt you to enter a file code
before the file copy begins. Enter the number ”"0” for ASCII text
files. As the file is copied from MS-DOS to APPLEDOS, the
eighth-bit of each character will automatically be ”set” to conform
with APPLEDOS standards. This feature can be deactivated from
the Options Menu for special applications. In general, however, it
should remain active.

Enter the number ”1” to indicate an APPLE Integer Basic file
(stored as integer basic tokens and strings, not converted to ASCII).
Enter the number ”2” to indicate an APPLESOFT file stored as
tokens and strings. Finally, a "4” indicates an APPLE 6502 binary
file. You can also cause the file to be copied to the APPLEDOS
disk as a “locked” or read-only file by adding 128 to each value.
For example, a locked text file would be indicated by entering 128,
a locked integer basic file by 129, and so forth.

As a note of warning, it is important to enter the correct file
type code. Otherwise, the file copied to your APPLEDOS disk may
subsequently not be directly usable in the APPLE computer. Since
MS-DOS programs do not wusually generate integer basic,
APPLESOFT, or 6502 binary files, these types of files are usually
copied to MS-DOS as an intermediate stop before being ultimately

4-13



copied to another APPLE disk.

Since most APPLESOFT files should be renamed as they are
copied to MS-DOS, you may want to use a filename convention
indicating the APPLESOFT file type. For example, you could use a
suffix of ".INT” for integer basic, ".APS” for APPLESOFT, and
”.65B” for 6502 binary files. This process is demonstrated in Figure
4-4.

"MY APPLE FILE” -- "MYFILE.APS” -- (2) -- "MY FILE”
1 l | l
| | file |
| APPLESOFT type |
APPLESOFT file file copied CODE |
on original to MS-DOS |
APPLE disk disk APPLESOFT
file copied
to second
APPLE disk

Figure 4-4. Example of Filename Conversions

In Figure 4-4, the original APPLESOFT file is copied to an
MS-DOS disk using ATREAD. The file is renamed
"MYFILE.APS” to conform to MS-DOS filename syntax. The
suffix “.APS” means APPLESOFT file. Months later, you need to
copy that particular file back to an APPLESOFT disk. Luckily,
you know that "APS” means APPLESOFT. Using ATWRITE, you
enter the file type byte value of “2” at the appropriate time.

4.4 Growth in File Size

Using ATREAD and ATWRITE with default options, a disk
file will tend to “grow” in size as it is transferred between disk for-
mats.
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This “growth” effect results from the way most operating sys-
tems distribute disk space. There is usually a minimum file size or
“disk storage unit” associated with any disk format or system.

A file can never be smaller than this minimum unit regardless
of the contents. The number of bytes or characters contained in a
unit will vary from system to system.

When you transfer files between systems with different mini-
mum “units” there will usually be an increase in the size of the file
on the destination disk. The unused disk storage space in the last
"anit” of a disk file is filled with a non-printing character. This is
the graphics character that you see at the end of a file when you
activate the “display” option with ATREAD or ATWRITE.

The “"Control-Z” program option is available for ATREAD to
avoid file size growth as it is copied from the APPLE disk to the
MS-DOS disk. This function operates through detecting a valid
"end-of-file” character (usually a control-z) and deleting the “pad-
ding” characters that remains in the last sector or record.

Generally, we recommend using the following techniques only

with ASCII files (preferably readable text or periodic data) where
you can visually check the accuracy of the deletion. Although these
methods can also be used with binary files, you can never be
absolutely sure that an end-of-file character is not being used for
some other purpose within a binary file.

In the unlikely event that an end-of-file character is being used
in the middle of a file for some other purpose, then using the
following techniques would result in deleting an important section.

Therefore, we recommend the following guidelines:

1. If slight growth in file size is not significant, skip this entire
section and don’t worry about it.

2. If you need to maintain files at their original size, and have no
method for checking the integrity of the files after being
copied and “shrunk,” then do NOT use these techniques with
binary files of any type.
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3. If you need to maintain file size and are certain that a
control-z or other end-of-file character cannot be buried in the
middle of a binary file, then use the following techniques for
binary as well as ASCII files.

4.4.1 Shrinking Files

After copying a file to an APPLE CP/M disk with
ATWRITE, file compression must be done on an APPLE computer.
Under APPLE CP/M, you can use the "PIP” command to shrink a
file.

However, the use of PIP and the syntax involved is
considerably different from the MS-DOS “COPY” command.
Please refer to your APPLE CP/M documentation for exact details.
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4.5 Using ATSIFT

Apple-Turnover can transfer any type of file from one disk for-
mat to another. However, this does not necessarily mean that the
file will be immediately usable in your specific application. The
ATSIFT program is intended to help you modify standard ASCII
text files, when required, for your applications. ATSIFT does not
work with binary files. Please refer to the "APPLPEEL” and
"UNPEEL” programs for binary files.

You can think of ATSIFT as a “post-processor” for the
Apple-Turnover programs. In other words, transfer your files to an
MS-DOS disk using the Apple-Turnover programs. Then, as
required, use ATSIFT to modify ASCII text files for the given
application.

For example, assume you want to use a document file created
by APPLE CP/M Wordstar with the Final Word word processor on
your IBM PC. Use the following procedure:

e Use Apple-Turnover to transfer the original Wordstar docu-
ment file to an MS-DOS disk.

e Use ATSIFT to convert the Wordstar document file to an
ordinary text file.

e Run Final Word using the newly created text file as input.

However, ATSIFT can do a lot more than convert Wordstar
document files. ATSIFT can modify ASCII text files in the
following ways:

1. Convert Wordstar document files to standard ASCII text files.
2. Strip the “high bit” from ASCII text files.

3. Remove a linefeed character after each carriage return charac-
ter.

4. Remove carriage return characters.
5. Remove combined carriage return & linefeed characters.

6. Do simple text search and replace functions.
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The next section presents instructions for using the ATSIFT
program. The tollowing sections present examples showing ATSIFT
functions in use. We strongly recommend that vou read the sec-

tions containing examples before using ATSIFT.

4.5.1 Operating Instructions

You should understand the terms “Source File” and
"Destination File” before proceeding. The Source File is the origi-
nal ASCII text file to be modified by ATSIFT. The Destination File
is the new, modified text file created by ATSIFT. All Source Files
and Destination Files must reside on MS-DOS disks.

Use the following procedure to modify text files with ATSIFT:
1. Begin by typing the command: ATSIFT [Enter].

2. After the title page appears on your screen, press [Enter] to
continue, or press the letter @ to quit and return to MS-DOS.

3. The next screen will prompt you to enter the name of the
Source File and the Destination File.

Enter each filename wusing the standard MS-DGS
syntax: Drive:Filename.Typ. For example, if the original file
is on Drive A and you wish to place the new, modified file on
drive B, then use the following syntax:

Source filename? OLD.TXT
Destination filename [OLD.TXT]? B:NEW.TXT

The drive letter is optional and should be used if the Source
File or Destination File reside on another disk drive.

The default filename is shown in brackets (c.g. [OLD.TXT])
under Destination Filename. If you press [Enter] in response
to this prompt, then ATSIFT will overwrite the original file.

should enter another filename for the new, modified file.

Make sure you have enough free space on the Destination File
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disk drive. As a general rule of thumb, you should have at
least two times the size of the Source File available as free
space. For example, if the Source File is 10K, you should
have at least 20K free on the disk. The extra space is required
because ATSIFT creates a temporary work file during
modifications.

After entering the Source and Destination filenames, the main
menu will be displayed as shown below:

Source Filename?
Destination Filename[]?

COMBINATION:
1. WS to ASCII
Remove Soft Carriage Returns|
Strip Hi Bit

INDIVIDUAL:
2. Strip Hi Bit
Add LF After CR
Remove LF After CR
Strip CR
Remove CR/LF Combinations
Replace String With Another

Novu s w

0. Exit to DOS

Which operation do you want to do?

Figure 4-5. ATSIFT Main Menu

Select the desired modification by entering the appropriate
number (1 to 7), or enter the number 0 to quit and return to
MS-DOS.

After selecting the modification, ATSIFT will perform the con-
version. After the conversion is completed, ATSIFT will
display the “Source Filename?” prompt. AT this point, you
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may enter the name of the next file to be modified. To quit,
simply press [Eater] in respense to both “Source Filename”
and “Destination Filename” prompts. When the main menu
appears, press the number € to exit,

.2 Application Examples

4.5
4.5.2.1 Converting Wordstar Files

Wordstar documents are stored as modified text files.
These files usually cannot be used by other word processors or
applications programs. ATSIFT can be used to convert Wordstar
“document ” files into ordinary ASCII text files.

For example, if you try to display a document file on vour
screen (using the MS-DOS "TYPE” command), you will see a mix-
ture of text and graphics characters. ATSIFT will convert the
graphics characters to ordinary text by stripping the “high bit,”
removing soft carriage returns, etc.

4.5.2.2 Strip High Bit
Many applications programs cannot use text files that have

the high bit set. ATSIFT will strip the high bit from appropriate

characters in a file. Use this option when a file appears to have
mixed graphics and text on the screen.

This ATSIFT function is similar to the Wordstar conversion
(No. 1 above), but more limited in scope. Don’t use this function
for Wordstar document files.

ASCII characters can be represented by a numeral from 0 to
255. Normal printable text characters {plus a few non-printing con-
trol characters) are represented by a value between ¢ and 127, If a
character has the “high-bit set,” it is represented by a comparable
value between 128 and 253

For example, the letter "A” is represented by the ASCII value
065 (decimal). Add 127 to 065 and you get the letter "A” with the
high-bit set. This becomes a graphics character on your IBM’s

video screen. The IBM PC character set uses ASCII value between .
128 and 255 to represent different graphics characters. That’s why ©

files with the high-bit set look like mixed graphics and text on your
screen.

4-20

R,




Therefore, stripping the high bit is equivalent to subtracting
127 from the value of an ASCII character when that character has
an original value of 128 or greater. This usually converts a graphics
character into an ordinary text character.

4.5.2.3 Add Linefeed After CR

NOTE

This ATSIFT function is used to convert APPLE Visicalc files
to Lotus 1-2-3 worksheet files.
Please refer to section 5.2.1 for more information.

Consider the following example. Assume that you create a short
note using the "HOCUS-POCUS” Word Processor on your APPLE.
The original note looks like the example shown below:

Hi Fred:
I am finally giving up on this silly
word processor. I plan to start using

a better one on my IBM real soon.

Bye for now ...

Figure 4-6. Original Text on APPLE

Now, you copy this file from the APPLE disk to an IBM
MS-DOS disk using Apple-Turnover. Since you are anxious to see
the file, you use the MS-DOS "TYPE” command to view the file on
your screen. Instead of the original text of your note, you see a
blur of letters ending with the single line shown on the next page.
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A>type FREDNOTE
Bye for now ... my IBM real soon.using
A>

Figure 4-7. Text Without Linefeeds

Is there is problem with Apple-Turnover? No, there is not.
Apple-Turnover always copies a file verbatim from one disk format
to another. The problem here is that the "HOCUS-POCUS” word
processor uses only a carriage return character to end each line.
MS-DOS (and most MS-DOS applications programs) expect each
line to end with a carriage return and linefeed character. When you
try to display the file on your screen, each line of text is being
directly overlayed on top of one another. The absence of linefeed
characters prevents the display from scrolling as it normally would.

The end of a line can be terminated by several different
combinations of carriage return or linefeed characters. Different
applications programs or operating systems may handle the “end of
line” situation differently, and cause compatibility problems. This
option will add a linefeed character to each carriage-return character
in a file.

4.5.2.4 Remove Linefeeds After CR

This ATSIFT function is the opposite of the previous one.
Instead of adding a linefeed character to each carriage return,
ATSIFT will remove one linefeed character from each carriage
return encountered in a file.

One possible application involves converting “double-space”
text into ”“single-space” text. Going back to the "FREDNOTE”
example of the previous section, assume you text looks like the
following example:
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Hi Fred:

I am finally giving up on this silly
word processor. I plan to start using

a better one on my IBM real soon.

Bye for now ...

Figure 4-8. Double-Space Text

Using the remove linefeed function of ATSIFT would convert
this file into text that looked like:

Hi Fred:
I am finally giving up on this silly
word processor. I plan to start using

a better one on my IBM real soon.

Bye for now ...

Figure 4-9. Single-Space Text

4.5.2.5 Strip CR or CR/LF
These ATSIFT functions can be used to prepare ASCII text
for later use with a word processor or text editor.

Ordinary ASCII text files use a carriage return and linefeed (or
less commonly just a carriage return) to end each line. Since most
word processors use a carriage return and/or linefeed to mark the
end of a paragraph, ordinary text files cannot easily be changed to
other formatting arrangements like right justification, etc. ATSIFT
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enables you to remove all carriage returns and/or linefeeds to make
text reformatting possible.

For example, lets say you have a short ASCII text file that is
currently unjustified (ragged right), and you wish to justify the text
using Wordstar. The initial text file is shown in the Figure below:

Hi Fred:
I am finally giving up on this silly
word processor. I plan to start using

a better one on my IBM real soon.

Bye for now ...

Figure 4-10. Original ASCII Text File

Using XSFIT menu option no. 5 (Strip CR), remove all carriage
returns. Then, load the modified text file into Wordstar (or some
other word processor) and right justify the text. The final, justified
text will look like:

Hi Fred:
I am finally giving up on this silly
word processor. I plan to start using

a better one on my IBM real soon.

Bye for now ...

Figure 4-11. Right-Justified Text File
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4.5.2.6 Search & Replace

This option (Replace String With Another) is similar to the
“search and replace” function found in most text editors or word
processors. The term “string” refers to a sequential group of text
characters, i.e. letters, words and spaces.

To use this function, press number 7 from the ATSIFT main
menu. The prompt find string? will be displayed. Type the letters
or words to search for. Press [Enter] at the end of the search
phrase.

Then, the prompt replace it with? will appear. Type the NEW
phrase which will replace the old one. Press [Enter] at the end of
the replacement phrase. ATSIFT will find each occurrence of the
old phrase and replace it with the new one.

For example, suppose you had a text file where you wanted to
replace the phrase “star-spangled banner” with “Old Glory.” You
would enter the following:

find string? star-spangled banner[Enter]
replace it with? Old Glory[Enter]

ATSIFT would then find and replace the phrase. Upon completion,

the screen would clear and the prompt Source File? would appear,
indicating that the prior process was completed.

4.6 USING APPLPEEL & UNPEEL

NOTE

These utility programs are intended for programmers
and others with a good working knowledge
of APPLE and IBM file structures.
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These MS-DOS programs are tools for binary files.
APPLPEEL can convert a binary memory-image file into a binary
byte-list file by stripping the file header. UNPEEL does the oppo-
site. It can convert a byte-list file into a binary-image file by adding
a file header. Header bytes often need to be removed or modified
when APPLE binary files are used in MS-DOS applications or vice
versa.

Since -this type of file sharing is quite specialized, most users
will not need to use APPLPEEL or UNPEEL. For those that do,
this section provides instructions. However, since we do not know
your specific application, we cannot advise on the more general
topic of using APPLE binary files in MS-DOS applications. That
part of the puzzle is up to you.

4.6.1 Operating Instructions

There are two basic ways to use the APPLPEEL/UNPEEL
programs:

1. Use APPLPEEL to convert a binary-image file into a byte-list
file by stripping off the file header.

2. Use UNPEEL to convert a byte-list file into a binary-image file
by adding a file header.

The general approach to using APPLPEEL/UNPEEL is
summarized below:

e To use APPLE binary files in MS-DOS applications:

1.  Create an MS-DOS program that will use the APPLE
byte-list file.

2. Use Apple-Turnover to transfer the APPLE binary file
from an APPLEDOS disk to an MS-DOS disk.

3. Run the APPLPEEL program under MS-DOS and strip
the header - converting a memory image binary file to a
byte-list binary file.

4. Run your MS-DOS applications program on the newly
created binary file.
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@ To use MS-DOS binary files in APPLEDOS applications:

1. Create an APPLE program that will use the MS-DOS
byte-list file.

2. Run the APPLPEEL program under MS-DOS and strip
the header from the MS-DOS file - converting a memory
image binary file to a byte-list binary file.

3. Use Apple-Turnover to transfer the MS-DOS binary file
from an MS-DOS disk to an APPLEDOS disk.

4. Run your APPLE applications program on the newly
created binary file.

4.6.2 APPLE Binary File Structure

Since the APPLPEEL/UNPEEL programs edit file headers, it
is important to understand APPLEDOS file structures. This section
briefly describes the binary image file structure created by the
APPLEDOS "BSAVE” command.

In the APPLE II, a binary file (Type 04) is an exact copy of
some portion of memory. This memory image is preceded by the
memory address (low order/ high order format) and the length.
This structure is shown schematically in the figure shown below:

2 bytes 2 bytes
LO HI | LO HI | MEMORY IMAGE
address length contents

|
Figure 4-12. APPLEDOS Binary File Structure

As an example, consider the hex dump of a typical APPLE binary
file (BOOT13) shown in the figure below:

The header bytes are shown in boldface type in the figure
shown above. In this example, the load address and file length on
an APPLE are:
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06 0C 00 05 20 58 FC A0 00 B9 4D 0C FO 06 20 ED
FD C8 10 F5 A9 BF 85 33 20 6A FD ADO0O 02 C9 8D
FO 21 9% Bl 9 DE C9 B8 BO DA 29 07 0A 0A 0A OA

etc.
Figure 4-13. APPLEDOS Binary File Hex Dump

LOAD ADDRESS: 00 0C converts to 0COOH as the load address
FILE LENGTH: 00 05 converts to 0500H bytes in length

Typically, these four header bytes are the bytes that need to
stripped from the file before using that file in an MS-DOS
application.

NOTE

The header bytes stripped by APPLPEEL can be
subsequently replaced by UNPEEL.
However, vou need to know the actual byte values.
If you ever intend to converi the stripped file
back into an APPLEDOS binary file,
make sure to record those values.

Incidentally, the structure of an MS-DOS binary image file is
different. It consists of a seven byte header as follows:
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Byte 1 - File type verification

Byte 2-5 - Load address

Byte 6-7 - File length

Figure 4-14. MS-DOS Binary Image File Structure
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S
USING APPLEDOS FILES

5.1 Filename Syntax
APPLEDOS filenames must conform to the following rules:

1. Filenames may be from one to 30 characters in
length. Any portion over 30 characters is
truncated by APPLEDOS.

2.  Any typable character except the comma ( , ) may
appear in the name. A blank space between two
“words” is also OK.

3.  Filenames must not contain any control charac-
ters.

Since APPLEDOS filename syntax is very different from MS-
POS, you will frequently need to manually convert APPLEDOS
filenames to acceptable MS-DOS filenames. This topic is covered in
the next section.

5.1.1 Converting APPLEDOS Filenames

Unlike CP/M and MS-DOS, APPLEDOS filenames have no
regular structure. Therefore, the MS-DOS convention of a period
{.) separating the filename and extension has no meaning. The sin-
gle asterisk (¥*) means any file, and is similar to "*.*” for MS-DOS
or CP/M. The singe pound sign (#) means query any file, and is
similar to the Apple-Turnover “#.# " for MS-DOS or CP/M.

In the Select Files menu, whenever you enter an asterisk for
copy all files or pound sign for query and copy all files, the
programs will automatically force you to rename all files as they are
copied. Using ATREAD, type a legal MS-DOS filename in response
to the prompt. Press [Enter] to accept the APPLEDOS filename
as-is ** ONLY ** if the APPLEDOS filename is ALSO a legal MS-
DOS filename.

The instructions noted above are extremely important. If an
illegal MS-DOS filename is entered, the result will be an error condi-
tion and the program will abort. For example, punctuation like
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commas, colons, backslashes, asterisks, questions marks, etc. should
be rigorously avoided. These will cause the program to crash with
MS-DOS displaying the totally inappropriate message: “Too many
files...”

If you simply press [Enter] in response to an APPLEDOS
filename with more than 12 characters, then the Apple-Turnover
programs will simply truncate the name MOST of the time. This
can also cause problems. If the APPLEDOS filename happens to
have a space between two words (which is legal for APPLEDOS),
then that space will be copied to the MS-DOS filename. However,
a space is not allowed in an APPLEDOS filename. You will not be
able to easily access or delete this file.

5.2 Application Notes

Visicalc to Lotus 1-2-3

There are two ways to transfer your Visicalc files to Lotus 1-
2-3. The first method involves the use of Visicalc "DIF” format
files. This is the easiest method. However it suffers from the
disadvantage that formulas are not translated — only numerical val-
Wes. This method is described below:

1. On the APPLE, save your Visicalc worksheet as a "DIF” file.

2.  Then, use Apple-Turnover to copy the DIF format files from
the APPLEDOS disk to an MS-DOS disk.

3. Use Lotus’ translate function to convert the DIF file into a
Lotus file.

The second method involves the use of the ATSIFT program.
Although an extra step is required, it will transfer formulas as well
as numerical values. This method is described below:

1. Use ApplewTurnover to transfer your Visicalc worksheet file
,i‘f( VC) from the APPLEDOS disk to an MS- DOS disk.

Us *;he{f“ATSIFT" rogram, select function number 3 (Add
nefeed) to add a linefeed to each carriage return in the
Visicalc file.




. 3. ' Use the Lotus 1-2-3 utility program "VCWKS.EXE” to trans-
late the Visicalc file to a Lotus format file. Make sure that
the newly created Lotus file has a ”“.WKS” suffix on the
filename.

5.2.2 Lotus 1-2-3 to Visicalc

Apple-Turnover does not currently have the capability of
translating Lotus 1-2-3 worksheet files into their Visicalc equivalents.
We are working on this enhancement. Please contact your dealer or
Vertex Systems for more information on the availability of this
enhancement.

5.2.3 Magic Window/Acewriter

This section describes the steps necessary to convert Magic
Window document files into MS-DOS text file. After the conver-
sion, most MS-DOS text editors or word processors can be used as
required. Magic Window is also known as "Acewriter” on Franklin
computers.

e APPLEDOS files with a ".MW” suffix or ending contain the
text. Copy these files to an MS-DOS disk using the ATREAD

program.

e After all files have been copied to MS-DOS disks, run the
APSIFT program. Two file conversion steps are required:

1. Select option no. 2 to strip the high bit.

2. Then, select option no. 3 to add a linefeed character to
each carriage return.

3. The file can then be further modified with almost any
text editor or word processor that accepts straight ASCII
text files. We have used Final Word and Wordstar.

e Load the file into your editor or word processor. The first
couple of lines will appear to contain a jumble of graphics
characters and random letters. Delete these lines with the
appropriate editor or word processor command.
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@ Any characters starting with an “Esc” character (shown as ~ in
Final Word) are left-over Magic Window characters, and
should be deleted or removed. Typical combinations noted
are:

— Esc-O (shown as 70)
— Esc-& (shown as "&)
— Esc-E (shown as "E)
— Esc-R  (shown as "R)

e The end of your converted Magic Window document file may
also contain a string of graphics characters used to “pad” or
file the remaining space in the last disk record. They are
typically displayed as a string of characters like
"@"@@ @@ @"”. This string of graphics characters should
also be deleted.

5.3 Incompatible APPLE programs

Apple-Turnover only works with normally formatted
APPLEDOS 3.3 disks. This eliminates all APPLE copy-protected
disks or files. Unfortunately, it also eliminates several popular
applications programs that do not use standard APPLEDOS disks
for data storage.

To date, the following APPLE applications programs produce
incompatible data disks and cannot be used with Apple-Turnover:

e PFS File
e DB Master

We have also had preliminary reports that the APPLE version
of Visifile produces data disks/files which are not compatible with
the IBM version of Visifile. This aspect is currently being
investigated.
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5.4 Converting BASIC files

If you are interested in converting APPLE BASIC programs
for use on your IBM or other computers, then you need to convert
the APPLESOFT or Integer Basic file from its normal type of disk
file (binary tokens plus strings) to an ASCII text file. Do this on
your APPLE computer before transferring the file with Apple-
Turnover.

Although there are several APPLE utility programs that can
do the job, we suggest that you refer to the APPLE ][ DOS Manual
which contains instructions and a short program for converting
APPLESOFT program files into their ASCII text file equivalents.
This APPLESOFT program is reproduced below for your
convenience:

1 REM CAPTURE APPLESOFT PROGRAM IN TEXT FILE
2 D$ = CHR$(4) : REM CTRL-D

3 PRINT D$; "OPEN LISTING”

4 PRINT D$; "WRITE LISTING"

5 POKE 33,30

6 LIST 2270,5130

7 PRINT D$; "CLOSE LISTING”

8 TEXT : END

In the APPLESOFT program shown above, the line numbers
2270 and 5130 should be replaced by the line numbers of the
APPLESOFT program in memory that you wish to capture. The
name of the text file which will contain the program is call
"LISTING” in the program. You can change the filename
LISTING to another file name if desired.
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USING APPLE CP/M FILES

6.1 CP/M Filenames

In general, CP/M filename syntax is identical to MS-DOS.
Therefore, there is no need to convert or modify filenames when
transferring APPLE CP/M files to MS-DOS. However, there is one
important exception.

The Apple-Turnover programs cannot handle filenames that
contain any punctuation like a comma (,), dash (-), semicolon (;),
etc. If your CP/M filename has any punctuation, then the Apple-
Turnover programs will abort, and you will receive the MS-DOS
error message: "Too many files at address ....”

In this event, you will have to go back into APPLE CP/M
and use the "REN” command to remove the punctuation from the
offending filenames.

6.2 Supported Formats

Apple-Turnover supports the APPLE CP/M disk format used
by the Microsoft ”“Softcard” for the APPLE ][ computer. In prac-
tice, the disk format used by the Appli-Card, the Micropro
Starcard, and the ALS Z-Card II should be acceptable to Apple-
Turnover as well.

There is a potential problem with APPLE CP/M version 2.20.
This version has a bug which does not allow CP/M to read the last
two directory sectors on the APPLE CP/M disk. Instead of using
all eight directory sectors, only six directory sectors are used. Since
each directory sector holds eight directory entries, Version 2.20
allows a maximum of 48 files per disk. This bug was corrected in
APPLE CP/M version 2.23 and later.

The Apple-Turnover software allows for 64 directory entries
per APPLE CP/M disk. Therefore, using the ATWRITE program,
you can create an APPLE CP/M disk containing a maximum of 64
files. If you try to use this disk on an APPLE under CP/M version
2.20, the first 48 files will be OK. However, the 49th through 64th
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file will NOT appear on the disk directory. The same disk read on
an APPLE under CP/M version 2.23 or later will show all 64 files.

In a similar fashion, Apple-Turnover does not support APPLE
CP/M variations with more than 64 directory entries or files per
disk. For example, the "Apple Dumpling” card seems to offer a
version of CP/M which allows 96 directory entries or files per disk.
The Apple-Turnover software will be able to read the first 64 direc-
tory entries. The additional files will not appear in the Apple-
Turnover CP/M disk directory display.

As of the publication date of this manual, CP/M PLUS (or
version 3.0) for the APPLE has not been tested for compatibility
with Apple-Turnover. Please contact your dealer or Vertex Systems
for more information.

6.3 Application Notes
6.3.1 dBASE II

The dBASE II DBMS package for APPLE CP/M is similar
to versions of dBASE II for generic 8-bit CP/M and MS-DOS.
You should be able to transfer your dBASE II files to MS-DOS
disks using Apple-Turnover, and then be able to use the files
directly with only a couple of modifications to some of the
filenames.

dBASE II command files use the suffix “.CMD” under CP/M.
When you transfer these command files to MS-DOS and wish to use
these files under an MS-DOS version of dBASE II, then these files
must be renamed with a ".PRG” suffix. Other dBASE 1I files like
".DBF”, ”.NDX”, etc. should function without changes to
filenames.

6.3.2 Wordstar

Wordstar document files are stored as ASCII text files with
the “eighth-bit” set. This explains the odd appearance of these files
when they are viewed directly using the "TYPE” command under
MS-DOS or CP/M. The characters that have the eighth-bit set
often display as graphics characters instead of text characters.
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Unaltered wordstar document files should be directly usable
under the MS-DOS version of Wordstar. If you want to use
Wordstar document files in other word processors or applications,
then they should be processed with ATSIFT after being copied to
MS-DOS disks.

Select the first option in ATSIFT (convert wordstar files) to
convert document files into ASCII text files.

6.3.3 MBASIC Programs

Program source code developed under APPLE CP/M ver-
sions of MBASIC can easily be transferred to MS-DOS. However,
that does not mean that the program will run on your IBM PC.
While MBASIC and MS-DOS BASIC share many commands, many
differences exist. Most MBASIC programs will have to be modified
by a competant BASIC programmer before they will run under
MS-DOS BASIC.

Use the following procedure to transfer MBASIC programs
from an APPLE CP/M disk to an MS-DOS disk:

1.  On the APPLE, save the BASIC source code or program as
an ASCII file. Use the following command: SAVE
"FILENAME"”,A where the letter A will cause the file to be
saved as ASCII text instead of BASIC tokens.

2. Then, use Apple-Turnover to transfer the file from the
APPLE CP/M disk to your MS-DOS disk.
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7
SOLVING PROBLEMS

Most problems using Apple-Turnover can be traced to one of
the following causes:

e Marginal disk drive performance
e Operator error
e Current limitations of the Apple-Turnover software

The first part of this section discusses the three problem areas
listed above. The next part explains the ERROR! screen and Error
Codes. The last part explores some common problems and solu-
tions.

7.1 General Problem Areas
7.1.1 Marginal Drives

When you use Apple-Turnover, you are asking your IBM’s
disk drives to routinely read and write two different types of disks:
APPLE’s "GCR” encoded disks and IBM’s "MFM” encoded disks.
This requires well-maintained drives in both your IBM and the
APPLE computer.

Sometimes, a disk drive can be in terrible shape, and still be
able to read and write its own disks. However, when you place a
similar type of disk (made on another drive) in the poorly-
maintained drive, all you get is errors. This becomes even worse
when you are trying to read disks using another encoding method
and operating system.

It is possible to have a situation where a set of disk drives can
read and write MS-DOS disks with no real problems. However,
attempts to read and write APPLE disks with Apple-Turnover are
only partially successful. This indicates that your drives are
sufficiently “out-of-tolerance” to have problems with APPLE disks.
However, the deviation from factory specifications is still small
enough to allow reading MS-DOS disks.




The disk drives on your IBM and Apple must be well
maintained. The recording heads must be clean, demagnetized, and
properly aligned. Disk drive rotational speed should be within 1%
of the specified value, and should not exhibit excessive rotational
speed variations.

If you get frequent, but random occurrences of disk read
errors on your APPLE disks, we encourage you to have your drive
or drives inspected by a competent specialist.

If you have a copy of the IBM Advanced Diagnostics Disk,
run the disk drive test sequence. This set of tests will detect really
bad drives, but will not reliably detect marginal disk drive perform-
ance. Several commercially available software products are offered
to test and analyze drive performance. You may want o investigate
using one of these utilities to further investigate drive performance.

7.1.2 Operator Error

The most common operator error selecting the wrong format
for the Apple disk. As a general rule, if you select the wrong for-
mat, you will get an empty directory or an Error Code 129 when
you attempt to read that disk.

ATREAD and ATWRITE read the directory of the Apple disk
before taking any further action. If you select APPLEDOS and try
to read an APPLE CP/M disk, the program will show an empty
directory.

7.1.3 Limitations

Apple-Turnover currently (12/84) has several limitations that
effect error handling. For example, the “low-level” routines that
interface the Apple-Turnover card to the floppy disk controller have
little ability to trap errors because of very tight timing loops
required to read the disk drive impulses.

As a result, severe disk errors which occur at just the right
instant can cause the Apple-Turnover programs to “crash” without a
return to the higher level software. This can cause your computer
to “hang” without any apparent recourse except shutting down the
power and rebooting. Please refer to Section 7-3 for additional

information.
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7.2 Error Responses

7.2.1 The ERROR! Screen

ERROR ATREAD

ERROR ENCOUNTERED DURING READ <1>
Drive not Ready. Please check ... <2>

Error code: 128 DRIVE: 1 TRACK: 1 SECTOR: 1 <«<3>

Please press:

[F1lRetry  [F2]lgnor [F3]Option [F4lFormt [F10]JAbort

Figure 7-1. ATREAD ERROR! Recovery Screen for ATREAD

Figure 7-1 shows the ERROR! recovery screen for ATREAD and
ATWRITE. The numbers shown in carets (e.g. <1> ) do not
appear on the screen, but are used as a key for the discussion that
follows:

1.  ERROR ENCOUNTERED DURING READ

This portion of the screen shows the general type of error.
In this example, the error resulted from an unsuccessful
disk read operation.
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2. Drive Not Ready ... Your computer is unable ...

This portion presents a brief description of the specific
problem suggested by the Error Code.

3. Error code:4 DRIVE:1 TRACK:3 SECTOR:1

The decimal value of the Error Code is displayed along
with the exact disk location where the error occurred.

4, Please Press:

This is the error recovery menu. Select the appropriate
response to the error by pressing one of the indicated
letters. The following material briefly discusses these
options:

RETRY - Try this first. Press the letter “"R” to attempt
the operation again. If unsuccessful, try pressing “R”
again. After four or five attempts, assume that this
approach is not going to work.

The numeric value in this line of the menu (not shown
above) refers to the number of times the disk system will
repeat the operation before generating an ERROR! screen
again. This numeric value can be changed within the
Options Menu

IGNORE - This response will skip problem disk location
and continue the previous disk operation. Use this
response with care. Sometimes this response can be a life-
saver, and other times it will cause even more problems.

Do not use the Ignore response if: (1) an error is
encountered while a disk catalog or directory is being read,
(2) an error is encountered reading any binary or other
non-text file like an APPLESOFT or Integer basic file, or
(3) an error is encountered in any file where total integrity
of the contents is important.

However, this option can provide a badly needed “last
resort.” A typical example might be a long text file for
word processing. If an error is encountered and skipped
using the ”I” option, then the transferred file would
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contain a bad or missing section corresponding to the
location of the read error in the original file. However, the
Ignore response would allow you to salvage the rest of the
file. Sometimes half a pie is better than none.

OPTIONS - This response moves you to the Options
Menu. Typical recovery attempts using the Options Menu
could involve switching the source and destination disk
drives in an attempt to read a marginal disk, changing the
number of error retries, etc.

FORMAT - Switch to the other APPLE disk format. This
is the proper response when the problems stem from a
mismatch of selected disk format and actual APPLE disk.
This is often the proper response when Error Code 129 is
shown.

ABORT - Return to DOS or system level. Provides a
graceful exit to DOS. Sometimes, discretion is the better
part of valor.

5. Function key commands

The function keys provide a convenient alternative to the
single-letter commands noted above.

The ERROR! recovery screens for ATREAD, ATWRITE and
ATINIT are quite similar. ATSIFT has no error recovery screen
because significant disk errors are rare and tend to be an MS-DOS
problem best solved elsewhere.

Significant differences between the three main programs are
noted below:

e ATWRITE offers the "Exit” response in lieu of ATREAD’s
"Abort” response. Exit will move you the the ”Exit” screen
instead of aborting the program back to DOS level.

e ATINIT does not offer the “Ignore” function. Ignoring an
error during a disk format or initialization is hazardous, and
is therefore not offered as a response.
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7.2.2 Error Codes

e Error Code 3 - Write Protected Disk This Error Code means
that your disk drive could not write a file to the destination
floppy disk because it is write-protected.

Look for a "write-protect tab” covering the notch on your
destination or target disk while using ATWRITE or
ATINIT. Remove the write-protect tab. Then, press "R”
or function-key [F1] to retry the disk operation.

e Error code 64 - Seek error

Apple-Turnover could not locate a track or read a secior.
The error message will report the problem track and secior.

The APPLEDOS and CP/M directory should be on track
17 (decimal), and the boot sector to be on track 0. Any
other track is indicative of a sector not found as a part of
the file being copied.

e Error Code 128 - Drive Not Ready

The drive read head was not engaged when Apple-
Turnover tried to read the disk. This problem can result
from many different (and easily corrected) problems like:
(1) disk not inserted in drive, (2) disk not properly
seated within drive, (3) disk drive door left open, etc., etc.

e Error Code 129 - Bad Data

This error code usually means that Apple-Turnover was
able to physicallv read the disk, but was unable to maks
any sense out of the data.

The most common cause of this problem is selection of the
wrong disk format. For example, selecting an APPLEDOS
format and inserting an APPLE CP/M disk in the drive
will cause an error of this type.

Minor disk media problems or marginal disk recordings P
which are not quite bad enough to cause an unsuccessful |
read may nonetheless cause an error 129,
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® Other Error Codes

Any other error code is a soft error from the Floppy Disk
Adapter Card, and is not related to the operation of the
Apple Turnover card. This type of error is both rare and
intermittent. A retry will generally continue with the trans-
fer without further problems.

7.3 Common Problems
7.3.1 Computer Hangs

If your APPLE disk contains bad sectors or other disk
defects, Apple-Turnover is usually able to trap these errors, and
provide the "ERROR!” screen to help vou recover from the prob-
lem.

Sometimes , error recovery is not possible. If this occurs, a
variety of unpleasant things can happen. Your video screen may
become blank or all white. Your disk drive may “hang” (light
remains on, motor spins indefinitely). In any event, you will

. probably lose control of the computer.

Do not become unduly alarmed. Turn-off the AC power, wait
15 seconds, and turn on the power to reboot your computer. Then,
try to determine what the problem might be in the APPLE disk and
restart the appropriate Apple-Turnover program.
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Appendix 1 -1

User Support

We try to provide the best possible level of user support to
our valued customers. Therefore, we require a valid product regis-
tration on file with our Customer Support Department before
providing help. Therefore, please note your product version and
serial numbers in any correspondence or telephone calls.

If you run into a minor problem or have any suggestions for
improving Apple-Turnover, we would like to hear about it. Use the
Problem Report Form in this package. Mail it to Vertex Systems
and include a sample problem disk if appropriate. We will
acknowledge receipt and get back to you with some answers as soon
as possible.

If your problem is more serious, contact your dealer or vendor
for support. If they can’t provide an immediate solution, they will
contact Vertex Systems for dealer support services and solve your
problem as quickly as possible.

If you have purchased this product direct from Vertex Systems
and need assistance, then please feel free to write or telephone.
Customer Support Personnel are generally available from 10:00 AM
- 3:00 PM (Western Time Zone), Monday through Friday. At other
times, our answering service will record your request and we will get
back to you as soon as possible.

Overseas, support is available through the following
organizations:

e United Kingdom:

— Microware London, Itd. (United Disk Memories/UDM),
London N19

e Western Europe:
— Dataplus Benelux BV, Waalre, Netherlands
— Dataplus Belgium, Brussels, Belgium

— Technical Marketing Consulting, Steenbergen, Nether-
lands
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— Polysoft, Drammen, Norway

— Software House Expander, Solna, Sweden
— Microsystems Data Systems, Vienna, Austria
— BSP Thomas Krug, Regensburg, West Germany

From time to time, we will make significant improvements in
Apple-Turnover or introduce other related software products.
Registered owners are eligible to receive upgrades at the lowest pos-
sible cost. Our upgrade policy is as follows:

e Customers who have purchased Apple-Turnover with a serial
number below 1300 are entitled to one software upgrade at no
additional cost.

® Replacements for damaged program disks and software
upgrades cost $20 postpaid. Please include your original
program disk with your order.
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incompatible Hardware

Computer Systems

IBM AT

Columbia MPC
Corona PC
Eagle Turbo X1,

Heath/Zen 150
iBs

Leading Edge
NCR PC

Olivetti M-18

Apple-Turnover does not currently work on the
AT. A new version is being developed. Please
contact your dealer or Vertex systems for infor-
mation on availability.

Require special cables to connect the Apple-
Turnover card. Contact your dealer or Vertex
Systems for assistance.

Requires special cables to connect the Apple-
Turnover card. Contact your dealer or Vertex
Svstems for assistance.

XL’s with Qume 142 disk drives will work OK.
X1’s with Teac drives will not work unless the
Teac drive is modified.

Apple-Turnover will not work reliably on both the
150 and 161.

The IBS computer (PC-compatible “look alike”)
will not work with Apple-Turnover.
Problems have been reported on computers with
Mitsubishi 1/2 height drives. Cables must be
swapped around to fit the computer.
The NCR PC-4 will not work with Apple-

Turnover unless one of the Teac disk drives is
modified. '

Apple-Turnover will not work with the Olivetti

© M-18 or M-24.

Sperry PC

Same as Leading Edge PC.



Disk Drives

Hitachi Drives

Matsushita Drives

Teac Drives

Vista Board

Appendix 2 - 2

Hitachi 505B disk drives
installed in an IBM PC will
not work properly.

Matsushita (Panasonic) disk
drives will not work reliably.

Apple-Turnover  will  not
work with TEAC half-height
disk drives unless they are
modified. Refer to these
Appendices for modification
instructions.

Some Vista floppy disk con-
troller boards installed in an
XT will not work with
Apple-Turnover.
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Installation in a Compag Computer

This Appendix describes the process of installing the Apple-
Turnover printed-circuit card in a Compaq computer. The process
is similar to the steps described in Section 2. However, there are a
few differences due to the different physical layout of the Compaqg
expansion slots.

The main problem is the short length of the Compaq disk
drive ribbon cable. There are two ways to solve this problem. The
first involves moving the existing floppy disk controller card and
video card (located in the first two slots towards the front) back one
slot. Then, plug the Apple-Turnover card into the free slot.

The second approach involves purchasing a longer disk drive
ribbon cable. The cable used in the IBM PC and many compatibles
should work OK, but will leave some excess cable which may be
difficult to fit into the small space around the expansion slots.

Assuming you wish to proceed with the first approach, the
following steps generally supplement or replace Steps 4 - 10 in Sec-
tion 2.2.1:

STEP A MAKE SURE THE AC POWER IS OFF BEFORE YOU
PROCEED.

Locate the disk drive controller board. Assuming that
you are facing the front of the Compagq, it is the first
card. The second card towards the back is the video
card.

Locate the pin connector where the short disk drive rib-
bon cable plugs into the disk controller board. Note that
there are two short levers on the sides of the connector.
These two levers lock the cable into the connector. To
unlock, push each lever sideways, away from the center of
the card. Remove the ribbon cable by lifting the conmnec-
tor.



STEP B

STEP C

STEP D

STEP E

STEP F

STEP G
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Remove the retaining screws from the disk controiler
board and video card. Save the screws. Remove both
boards by lifting vertically. You may find it convenient
to temporarily remove the round cable that plugs into the
center of the video card. If the third slot from the front
contains a card, move it back one slot as well.

(See Figure 2-3) Plug the original disk drive cable into
the Apple-Turnover pin connector (J2). The colored
stripe on the cable should be oriented towards the top of
the Apple-Turnover card.

Locate the female card-edge connector on the new ribbon
cable (supplied). Plug it into the Apple-Turnover card
male card-edge connector (J1). The colored strip on the
new cable should be oriented towards the top of the
Apple-Turnover card, just like the cable in Step C. Make
a 90-degree bend (free end oriented towards top of
Apple-Turnover card) in the new ribbon cable.

Plug the Apple-Turnover card into the first expansion
slot. You may have to rotate the Apple-Turnover card as
you insert it into the available space to position the cabies
properly.

Plug the free end of the new ribbon cable into the disk
drive controller card (now in slot 2). Push the connector
in firmly, but gently. Push the locking levers in, towards
the center of the board to lock the cable in.

Reinsert the card retaining screws for the disk drive and
video boards. If yvou removed the video cable from the
video card in an earlier step, be sure to reinstall it.

The Compaqg computer used a non-standard retaining
screw for the first three slots. Therefore, there is no neat
way to secure the Apple-Turnover mounting bracket.
However, with the covers properly installed, the card will
be OK without additional retaining screws.
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Modifying Teac Drives

Teac half-height disk drives have become a popular alternative
to full size disk drives. Unfortunately, Teac drives must be
modified to work properly with Apple-Turnover. The required
modification will have no effect on normal operation.

The modification consists of soldering a resistor onto the Teac
disk drive electronics board. Please do not perform the
modification yourself unless you are familiar with removing and
replacing the disk drive, component identification, and soldering.

If you feel uncomfortable doing the modification vyourself,
then contact your dealer’s service department or other computer
repair service for assistance. Alternately, Vertex Systems will mod-
ify your disk drive for a charge of $50.00 plus shipping.

NOTE

Vertex Systems Inc. provides this modification as a courtesy and
assumes no liability whatsoever for modifications performed by the
user or other repair services.

Required Materials
@ 150 ohm, 1/4 watt resistor (5% tolerance or better)
e The following tools are recommended:
— low-wattage soldering iron
— desoldering tool or toothpick
— small crosshead screwdriver

— needle-nose pliers

This modification may void your Teac disk drive or computer warranty.
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Modification Instructions

These instructions apply to 40-track Teac disk drives, Model

. FD-55B-01-U and may vary slightly for other models.

Remove the Teac disk drive from your computer.

Turn the drive upside down so the large motor shaft flywheel
is visible. Locate the dark green main board (also contains
the power connector and card edge connector.

Remove the three cross-head screws that secure the main
board to the drive chassis.

Disconnect all cable connectors from the board. Use a pair of
needle-nose pliers and carefully note the configuration (make a
sketch if necessary). There are four connectors. Two large
white connectors (marked 6 JST and 4 JST) are located on top
of the board. The other two black connectors are located on
the underside of the board near the head-load solenoid.

Locate C29 and C30 on the board (components NOT installed)
as shown in the drawing below:
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Remove the solder from the top holes of locations C29 and
C30. Insert and solder the 150 ohm resistor into these two
holes as shown below:
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7. Replace the Teac board making sure that all four cable con-
nectors are properly connected.

8.  Replace the disk drive in the computer and test the drive with-
out installing the Apple-Turnover board to make sure every-
thing is OK.

9. Replace the Apple-Turnover board in the computer.

Modifying Older Models

Older Teac half-height drives can be identified by the presence
of circuit boards on both top and bottom of the drive. Use the
same procedure as above with the following exceptions:

e Remove the circuit board from the top (instead of bottom)
side of the disk drive. This is the read/write board.

e Locate the single in-line resistor pack labeled RA308.

e Connect and solder the 150 ohm resistor across pins 4 and 5
of the resistor pack.
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APPLE HIRES Conversion Option

What about Apple HIRES picture files? Yes, Apple-Turnover
will transfer ANY APPLEDOS 3.3 or Apple CP/M file. However,
the hardware is different, so the picture will not display properly on
your IBM video screen.

Can we do anything about getting Apple pictures to display on
the IBM-PC? Yes, the Apple-Turnover Graphics utility package can
transform, display and rotate Apple II picture files for use on your
IBM’s video system. The utility package consists of three programs
providing a lot of graphics interchange value.

Apple owners can create a disk file which contains the hi-res
graphics screen image. Then, use the ATREAD to copy the file to
an MS-DOS disk in your IBM. The first graphics program,
ATGRAPH, converts the data the data in the APPLE HIRES pic-
ture file to conform to IBM screen graphics format.

Since the resolution on the IBM color graphics adapter is
higher than Apple II screen graphics, he also makes some changes
so that the resulting picture will not appear visually deformed. The
resulting file may then be displayed on your IBM video screen using
the ATDISP program. The picture may also be sent to a graphics
printer using the PC-DOS utility “"GRAPHICS.”

If the colors do not suit you, the program ATROTATE
enables you to change each color in the picture to any other color.
We call this color change process rotation because the colors
displayed on the screen are controlled by certain bits set in the attri-
bute byte of pixel data. The ATROTATE program rotates these
bits at the touch of a key.

This optional graphics utility package is available only to
registered Apple-Turnover users for the price of $49.50 plus ship-
ping. Contact your dealer or Vertex Systems directly to get addi-
tional information or to place an order.
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LIMITED WARRANTY

VERTEX SYSTEMS, INC. warrants the APPLE-TURNOVER board to be free of
manufacturing defects for a period of ninety (90) days from the date of original pur-
chase. This warranty does not include damages to any of these products resulting
from misuse of accident.

VERTEX SYSTEMS, INC. warrants the original APPLE-TURNOVER software disk-
ette to be free from defective materials and workmanship in normal use for a period
of ninety (90) days from the date of original purchase. If, during this period, a defect
in the diskette appears, the diskette may be returned to VERTEX SYSTEMS, INC. for
replacement without charge provided that you have signed and returned your regis-
tration card to VERTEX SYSTEMS, INC. The supplied software programs, manuals,
and reference materials are sold “AS I1S” without warranty as to their performance,
merchantability, or fitness for any particular purpose. The entire risk as to the results
and performance of these programs is assumed by the user.

This warranty is in lieu of all other warranties, expressed or implied, including the
implied warranties of merchantability or fitness for a particular purpose, whether
arising by law, custom or conductand these rights and remedies provided under this
warranty are exclusive and in lieu of any other rights and remedies. This warranty
gives you specific legal rights, and you may have other rights which vary from state
to state. In no event shall VERTEX SYSTEMS, INC. be liable for consequential, inci-
dental, indirect, special, or similar damages or lostdata or profits to you orany other
person or entity even if VERTEX SYSTEMS, INC. has been advised of the possibility
of such damage. Our liability forany damage to you or any party in the event thatany
any of the above limitations are held unenforceable shall not exceed the original
purchase price regardless of the form of any claim.

If the APPLE-TURNOVER board becomes defective within the stated warranty
period, VERTEX SYSTEMS, INC. will elect to repair or replace it free of charge in-
cluding free return shipment, provided a signed warranty card is received by, and
the product is sent prepaid to VERTEX SYSTEMS, INC., 6022 W. Pico Boulevard,
Suite 3, Los Angeles, CA 90035.

This agreement covers any updates, backups, and replacements, and constitutes
our entire understanding and agreement.

rtex

systems inc.

INNOVATION IN MICROCOMPUTER PRODUCTS

6022 WEST PICO BOULEVARD, SUITE 4
LOS ANGELES, CALIFORNIA 90035
(213) 938-0857
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LIMITED USE LICENSE AGREEMENT

Thank you for selecting APPLE-TURNOVER for your IBM Personal Compter. This
document contains our Limited Use License Agreement and also describes our up-
date policy. See the above Limited Warranty for warranty information. Once you
have read the warranty agreement and this license agreementand agree to its terms,
please complete in FULL, sign, and return to VERTEX SYSTEMS, INC. the attached
registration card. When this card is signed by you and. received by VERTEX
SYSTEMS, INC., this will be the agreement between us governing the use of the
subject software, hardware, and documentation. The FULLY COMPLETED card
when received by us will entitle the registered user to technical support by phone
and backup/update diskettes at the current nominal fee. Sorry, incomplete cards are
not acceptable.

LIMITED USE LICENSE AGREEMENT

1. LICENSE GRANT. VERTEX SYSTEMS, INC. hereby grants to you and you
accept a license to use APPLE-TURNOVER and related materials delivered with this
agreement, on a single computer or on a subsequent but not additional computer.
You agree that you will not transfer or sub-license your rights under this agreement.
VERTEX SYSTEMS, INC. reserves the right to sell or give ticenses to use APPLE-
TURNOVER on more than one computer system, then you must either license
another copy or request a multi-use license from VERTEX SYSTEMS, INC.

2. TERM. This license agreement is in effect from the day you receive your
APPLE-TURNOVER package until you return the original materials and ail backup
copies to VERTEX SYSTEMS, INC.

3. VERTEX SYSTEMS, INC.’S RIGHTS. You acknowledge that the software and
related materials are the sole and exclusive property of VERTEX SYSTEMS, INC. By
accepting this license, you do not become the owner, but you do have the right to
use these materials as outlined and limited by this agreement. You further agree not
to transfer the board, software, and related materials in any form to any person
without the prior written consent of VERTEX SYSTEMS, INC. You will use your best
effort and take all reasonable steps to protect APPLE-TURNOVER from
unauthorized reproduction, publication, disclosure, or distribution.

4. USER AGREEMENT. You agree not to copy the package or documentation or
related materials received from VERTEX SYSTEMS, INC., inwhole orin part, unless
VERTEX SYSTEMS, INC. consents in writing.

5. LIABILITY. You agree that regardless of the form of any claim, VERTEX
SYSTEMS, INC s liability for any damages to you or any other party shall notexceed
the license fee paid for the APPLE-TURNOVER package and related materials.

6. UPDATES. Should you wish to upgrade your APPLE-TURNOVER to a later
version, you may exchange your original package with accompanying payment as
quoted by VERTEX SYSTEMS, INC. Software upgrades will be accomplished in a
like manner.

7. GOVERNING LAWS. This license agreement shall be governed and
interpreted in accordance with the laws of the state of CALIFORNIA. [f any provision
of this license agreementin any way contravenes the laws of the State of Jurisdiction
in which this license agreement is to be performed, such provisions shall be
declared by final adjudication to be illegal or contrary to public policy, it shall not
affect the validity of any other term or provision of this license agreement.

8. ATTORNEY’S FEES. if any legal action is brought by either party to this license
against the other party regarding the subject matter of this license agreement, the
prevailing party shall be entitied to recover, in addition to any other relief,
reasonable attorney’s fees and expenses.

9. WHOLE AGREEMENT. This license agreement constitutes the entire software
license agreement between you and VERTEX SYSTEMS, INC.




